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TreeTop 7.1.2882.0 (February 17th, 2025) 

This release of TreeTop addresses a bug in the macro execution timing for Tornados. We 

recommend that users that are using Excel VBA macros update to this version of TreeTop. 

Excel VBA macros that were set to be executed Before Calculation were executed before all 

substitutions had been performed. This was inconsistent with the identically worded macro timing 

on trees. 

The macro execution order on Tornados is now much more closely aligned with tree node macro 

execution settings. All substitutions are made, then the Before Calculation macro, if any, is executed. 

This is followed by the calculation of the model. Lastly the After Calculation macro, if any, is executed. 

To take advantage of the different Tornado timing, simply switch to manual calculation mode and 

Reset / Recalculate the entire project.  
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TreeTop 7.1.2880.0 (January 2nd, 2025) 

This release of TreeTop is a re-release of version 7.1.2873.0 with an additional bug fix. 

When re-linking a different version of an Excel workbook to an existing TreeTop file, linked 

probability cells would sometimes not be updated correctly to point to the new workbook. 

TreeTop 7.1.2873.0 (December 6th, 2024) 

This release of TreeTop includes a new Add Nodes panel as well as a number of quality-of-life 

improvements that have been suggested by the client base in addition to several bug fixes. We 

recommend that users update to this version of TreeTop. 

New Add Nodes Panel 

We have added a new simplified “Add Nodes” panel layout that combines the classic “All” and 

“Append” panels. To access this panel, go to Options – Tree and change the option under Add Nodes 

Toolbox Panel. 

Trees 

After creating a decision tree with the Value of Information tree wizard, the node properties VOI / 

Delta section’s Base Branch drop-down did not refresh correctly until unselecting and reselecting a 

node once. 

Very rarely, TreeTop would not show the Substitution Target range when multi-selecting nodes that 

had the same range. Changing tabs to a different tree and coming back would then allow the multi-

selection and multi-editing operation. This was a refresh issue that has been fixed. 

Tornados and Tornado Comparisons 

The tornado or tornado comparison title has been added to the chart, in addition to the metric. This 

removes the need to manually add the title to presentation slides. 

The tornado comparison legend line breaking has been reviewed. It is now significantly more 

intelligent and takes both title lengths and available screen real estate into account to avoid 

shortening of titles in many situations, whilst being more compact in other scenarios with short 

titles. 

When using extremely long metric names, the tornado editor could show quite small cell picker 

boxes.  
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Sensitivities 

When creating sensitivities from tree, there could be a display problem if the user was currently 

viewing the Joint Probability metric, since sensitivities do not support this metric. If this happens 

now, the first valid metric is shown instead. 

Updating sensitivity axes titles did not always immediately change chart captions. 

The sensitivity heat-map legend could compute the wrong mid-point value. Note that this was a 

display bug with legend labeling only. 

One-way sensitivities now show hover-data when in decision policy plot mode. This works if 

hovering anywhere over the chart background but may sometimes not work when hovering directly 

over a data point marker. 

Excel and Windows Interoperability 

We have added better error handling with user messaging when Excel start-up problems occur. 

TreeTop is now much more resilient to blocking dialogs etc. whilst picking ranges.  

If a named range has been moved, TreeTop now places the cell picker in a much more correct 

location than previously to reduce confusion. 

TreeTop now records much more detailed diagnostic log messages if macro failures occur. 

We have increased time-out and added crash avoidance code in multiple hot spots where it was 

possible to recover from communication failures due to high system loads etc. 

Screen Capturing 

We have added 16:9 aspect ratio screen capturing and changed the labeling to make this clearly 

distinguishable from the already present 16:10 aspect ratio capture. 

Initial Metric Configuration 

We updated the out-of-box metric configuration to be NPV, Cost and IR (defined as NPV / Cost). 

Previously, the initial setup was Revenue and Cost. There was no ratio metric defined.  

This does not impact existing projects. The change is only visible to users that have not configured 

and then saved a metric setup in the past, and where there is no metric setup distributed as part of 

an internal installation script. 

  



 

© 2025 Decision Frameworks L.P. All rights reserved.  Page 4 

TreeTop 7.0.2813.0 (June 26th, 2023) 

Released as 7.0.2806.0 on June 8th. Re-released with additional bug fix. 

This release introduces multiple instances of TreeTop to be open at the same time, as well as a 

number of minor improvements and bug fixes. 

Support for Multiple Instances of TreeTop 

TreeTop now supports multiple instances running in parallel. To run multiple instances, a new 

instance of TreeTop must be launched manually by the end user. This can be done, for example, by 

launching an additional instance of TreeTop from the Start Menu or by double-clicking on an 

additional TreeTop file in the Windows File Explorer. 

Opening a Project from within TreeTop will close the current project, if one is already open. I.e., this 

will not launch a new TreeTop instance. 

This model of supporting multiple instances adds a little bit of additional memory pressure, because 

the TreeTop application is started up multiple times. The advantage is that Windows takes over the 

task scheduling – potentially assigning a different processor to each TreeTop / Excel set. 

Normal Windows conventions apply for working with software where each instance is a separate 

process. In particular, changing TreeTop Options only applies to the current instance; changes 

options are written to the system upon application close and apply to newly launched instances 

after that. Note that each instance writes settings upon closing – potentially overwriting changes 

from a previously closed instance.  

Tornado Performance Improvements 

We have significantly improved the performance of the Tornado editor as well as the Tornado range 

wizard. The performance issues only impacted usage scenarios where 80 or more variables were 

selected. 

Calculation Performance Improvements 

Manual calculation runs of trees and documents based on trees (range of value curves and 

sensitivities) are significantly faster now. 

Minor Changes and Bug Fixes 

The two-way sensitivity chart datapoint pop-up description now contains an indication of VOI / Delta 

mode, if this mode is active; this is parallel to the behavior of axes labeling for sensitivities. 
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Chart tick-mark labels (sensitivities and range of value curves) could be cut-off under rare 

circumstances. 

Tornado charts did not apply quick changes to the number of decimals immediately for the in-bar 

rendered results. 

Manual Tornados could cause a crash in the Tornado to tree wizard if the input information was not 

supplied. 

A crash could occur very rarely when working with game trees where the logic nodes had three or 

more choices and were edited multiple times. 

Deleting variables from the second dimension of a two-way sensitivity would not delete from the 

second dimension. Variables were deleted from the first dimension instead, without updating the 

user interface. 

Reset of sensitivities did not fully reset results prior to calculation in scenarios where the underlying 

tree was built using tree links to connect sub-trees. [v2813] 

For a very specific value of information tree setup, the Edit Probabilities button was not available 

when it should be. 
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TreeTop 6.1.2774.0 (December 9th, 2022) 

This release is a bug fix release. 

Trees 

The order of pasted sibling branches could be different from the copied (or cut) branches. This 

occurred if the order was changed (using the move branch up/down buttons on the tree document 

ribbon). 
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TreeTop 6.1.2770.0 (October 10th, 2022) 

This release of TreeTop includes an improved tree layout algorithm in addition to a number of 

maintenance changes and fixes. 

.Net Version 

TreeTop, DTrio and Owl are now built against .Net 4.8 (was 4.6 before); v4.6 is no longer supported 

by Microsoft and will no longer receive security updates. If you are using operating systems older 

than Windows 10, you may need to manually install the .Net framework 4.8 (or newer). 

Authenticode Signing and Strong Naming  

All assemblies (the various dll/exe files that make our applications) are now “strongly named”. This 

adds tamper-protection to the binaries, thus eliminating the possibility of someone taking our code, 

decompiling it, adding malicious code to it, recompiling it and distributing it.  

All dll/exe files as well as the installers are also Authenticode signed in addition to strongly named. 

This verifies the origin of the files and reduces or removes the security warnings that are displayed 

during installation. 

New Application Options 

We added new user options for the colors used in the monochrome tornados (Black White / Hi-Lo 

charts), as well as for the Default Calculation Mode (Automatic or Manual Calculation). The default 

calculation mode setting only applies to new projects. 

Trees 

We have been working on changes to the on-screen layout algorithm for quite a while. As these 

changes impact core functionality, they required significant testing. In this release, the changes are 

going live. Trees with linked nodes and/or tree links benefit most from these changes. 

We have also made some other minor rendering improvements. 

Performance Improvements 

The drawing of trees utilizing tree links has been massively sped up. In addition, the performance of 

the layout algorithm for large trees (usually due to tree links) has been improved significantly. 

Usability Improvements 

When using the “Append” mode to add nodes to a tree, the new nodes can be dropped onto any 

node, not just the middle node. 

We also changed which branch is unlocked for an even number of branches to be “round towards 

the top”. E.g., for two branches, the top probability is now unlocked by default. Due to this change, 
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some trees may show a different expand/collapse state from when they were saved with the older 

versions of TreeTop. Please change expand/collapse and re-save. The old expand/collapse state is 

not upgradeable under some circumstances. This is a one-time issue only applicable to the visual 

state of the tree, not to any of the underlying calculations. 

Based on user feedback, the hover tooltips for nodes are hidden by default. These tooltips allow 

pre-viewing of node results for pure combinations of view- and decision-metric. To change whether 

tooltips are shown, go to Options → Tree → Show Tooltip. 

Bug Fixes 

The rendering did not update when a linked tree was expanded and the tree link node was changed 

to a different node type (e.g., uncertainty). 

Dis-allowed node-linking of Tree Link nodes that pointed to different trees. This should not be 

allowed, because this is a dependency (correlation) in the tree. 

There could be a very rare crash when using tree links due to a bad look-up of joint probability 

intermediate results. 

The Tree Link expander was missing from screen captures. 

Expand / collapse of sub-trees and tree links made more intuitive based on user feedback. We also 

heavily optimized this operation for large trees. 

The VOI subtree builder omitted setting reward cells for single cell targets on the no info/no go 

branch when creating VOI trees that were using model cells for uncertainties/decisions and results. 

Tornados and Tornado Comparisons 

We added a new ribbon button to display base inputs on the Tornado/Tornado Comparison side-

legend. For consistency, the Show Inputs is relabeled to Min/Max Inputs. 

Sensitivities 

There were very rare crashes due to layout issues on very high-resolution displays.  

The error checking for sensitivities was slightly too aggressive and could cause a crash. 

Additional Bug Fixes 

When a project is opened whilst another is already opened (i.e., unload project TreeTop file A to 

open TreeTop file B), the cell picker code could crash.  

Whilst opening TreeTop, users could cause a crash by overloading the keyboard handling code by 

accidentally pressing and holding control keys (Ctrl / Alt / Shift etc.). 
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TreeTop 6.0.2709.0 (January 17th, 2022) 

This release of TreeTop adds two new document types (sensitivities and manual tornados), as well 

as new features and improvements for all other document types. We have also added export 

functionality throughout the application. 

.Net Version 

TreeTop – as well as DTrio and OWL – are built on .Net 4.6 in this release. If you are using operating 

systems older than Windows 10, you may need to manually install the .Net framework 4.6 (or 

newer). 

Excel files on Microsoft OneDrive/Microsoft SharePoint 

We added a feature to TreeTop to fully support linking to Excel files that are stored on 

OneDrive/SharePoint directories. This makes the previous work-around to move files to a local 

directory on the computer unnecessary. 

Application Shell 

We have improved the ribbon backstage (“the File menu”) by adding icons, introducing a new Home 

tab and updating the New and Open tabs. In addition, we have also made usability improvements to 

the project navigator, to make it easier to re-order project entries by greatly increasing the mouse-

sensitive portion of each project item. We have also optimized various document ribbons in this 

release to ensure better sizing. 

Bug Fixes 

TreeTop could crash during start-up if specific keys were pressed during the initialization sequence 

of the window. 

Metrics 

We have added the option to specify an offset and added user choices for division by zero handling 

for simple ratio metrics. This now allows metrics such as “PI = (NPV / Capex) + 1”. 

Data Export 

We have added a number of export functions to TreeTop and consolidated old and new export 

functions in a section on the Home ribbon. Our new generic export implementation supports 

Microsoft Excel-ML in addition to comma separated values. The Windows clipboard supports 

multiple data formats simultaneously. This means that the application in which you paste data will 

choose the data format that is best suited. If you prefer comma separated value over Microsoft 
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Excel-ML in Excel, for example, you can choose “Paste Special” in Excel to choose comma separated 

values. 

Excel-ML files have the “xml” file extension. Unfortunately, this is a shared file extension and a very 

common data format (Extensible Markup Language) also uses this extension. On many computers 

this results in xml files to be opened in the default internet browser. If this happens, open Excel and 

choose File -> Open to view and edit Excel-ML files generated by TreeTop. 

TreeTop now supports export from Tornados, Tornado comparisons, range of value curves and 

sensitivities.  

The range of value curve export features that were available previously still exist but have been 

migrated to the new data export buttons on the Home ribbon. We have augmented the old CSV 

export with Microsoft-ML export for the range of value curve data. 

Tornados 

The Tornado editor has been rewritten to a large extent; the remaining pieces have been updated. 

◼ The scrollbar design now works much better and allows scrolling to see only variables in 

scenarios where the Tornado has many variables. 

◼ The editing of dependency information between variables has been changed to be more 

obvious to use, even for users that are not used to dealing with dependencies between 

variables. 

◼ The view switch (Detailed vs. Compact) has been retired as part of these changes. 

◼ The flow of the editor has been changed slightly to accommodate more information to be 

displayed in the same screen real-estate for many use cases. 

◼ The input fields for most on-screen components have been made wider to make it easier to 

read Excel references. 

◼ Variable order can now be changed via drag-drop. 

Manual Drop Lines 

Users can now add manual drop lines to tornados. These can, for example, be used to identify the 

value of specific deterministic scenarios on tornado charts. 

The drop lines editor is available from the Document ribbon. 

Macro Execution Order 

The macro execution order was changed slightly and now mirrors the macro execution order of the 

tree that is generated using the Tornado to Tree wizard. 

The changes should not change any results generated by projects using macros in Tornados 

previous to this change. However, the before/after calculation macros are now called for every bar, 

not once per Tornado. 
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This change enables the use of macros to generate Tornados from third party calculation engines, 

using Excel as an intermediary. In particular, those clients that are currently working on TreeTop / 

PetroVR integration via Excel are now able to generate Tornados (and thus Tornado comparisons) 

from PetroVR projects. 

Tornado to Tree Wizard 

The wizard dialog has been updated overall. Some of the highlights include: 

◼ Variable re-ordering is now supported via drag-drop.  

◼ The sorting of variables by variance of a metric is more clearly indicated. 

◼ Error/Calculation messages are displayed in the table in addition to prompts. 

◼ Dependency information is shown only when the underlying Tornado contains 

dependencies. 

◼ Additional fly-over help has been added for novice users. 

◼ Edited the end-user instructions. 

◼ A size information / confirmation was added when creating large trees with the wizard (729 

or more end nodes for Excel; 81 or more end nodes for Enersight). 

Performance 

When creating a tree from a Tornado, results that have been calculated are inserted into the tree 

directly without recalculation. 

Manual Tornados 

TreeTop now natively supports manual entry Tornados. Manual entry tornados are a separate 

document type accessible from the Home ribbon. The Add Tornado button adds a calculated tornado 

by default (Excel or Enersight). Manual Tornados are available as a drop-down option from that 

button. 

Manual Tornados are first class documents, including support for Tornado to tree workflows and 

Tornado comparisons. 

Tornado Charts 

We have improved the automated font scaling that takes place when many bars are added to a 

single Tornado to ensure that values remain readable for a much larger number of bars. 

Tornado Comparisons 

Editor 

We have updated the Tornado comparison editor and moved it into a side-bar. In addition to now 

supporting drag-drop and a cleaner user interface, this allows collapsing of the side-bar to hide the 

editor once all required tornados have been added to the comparison. 



 

© 2025 Decision Frameworks L.P. All rights reserved.  Page 12 

Legend 

We added new legend options to the Tornado comparison. The legend highlights which Tornado 

bars on the comparison originate from. The legend changes its appearance automatically to support 

the various views that a comparison can be changed to. 

Tornado Comparison Charts 

We have improved the automated font scaling that takes place when many bars are added to a 

single Tornado comparison to ensure that values remain readable for a much larger number of 

bars. 

Trees 

Value of Information and Delta Display settings for Decision Nodes  

Decision nodes have a new Delta / VOI settings section under the node properties. If switched on, a 

value of information or delta value is displayed next to each branch of the decision node. The 

delta/voi value is calculated as the difference to a user-specified base branch of the decision node. 

Contextual Tree Links 

We have changed the tree link implementation to take (Excel-)context into account. Whereas 

previously a linked tree always had the same results, regardless of link-origin, the origin is now 

unfolded to calculate the tree in that specific context (i.e., taking any substitutions that happen “to 

the left” into account). 

This change has a number of important ramifications: 

◼ In rare circumstances, older files that utilize tree links may generate different results! If this 

is undesirable, you can make appropriate substitutions at the root of the tree that is linked 

to, to correct this. 

◼ Trees can grow unexpectedly large very quickly. Every tree that is linked to now exists 

multiple times in memory. 

◼ This feature can be used to model many very complex problems very easily. 

We will make a white paper with details and walk throughs available shortly after release. 

Value of Information Wizard 

Trees that have been created using the VOI wizard can now be edited to change the probabilities. 

This works as long as the VOI subtree has not been changed. 

Bayesian Revision 

The Bayesian revision now executes immediately (without showing a confirmation dialog) if there is 

only a single revision candidate. If multiple options to revise with exist in the tree, the dialog is 

shown to allow the user to select the correct node to revise with. 
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Bug Fixes 

It could be hard to edit the column width of the right-most tree level in multiple metrics view, when 

horizontal metric layout was selected. The mouse-over area was partially obscured by metric name 

labels. 

Range of Value Curves 

User Data Points 

Data points can now be added to each series. This can, for example, be used to mark specific 

deterministic scenarios that have been calculated but are not present in the underlying tree. 

Another use is to manually show lines for internal hurdles etc. 

Performance 

We have re-written parts of the charting engine to dramatically increase performance for large 

projects (many thousand end nodes). A test project with ca. 50.000 end nodes now renders in 

approx. 2 seconds, where it could take up to two minutes to fully generated the chart previously. 

New Highlight styles 

The charting performance improvements allowed us to implement additional options to highlight 

data points. In addition to the flash that has been available previously, there are now beacon and 

chevron animations. 

We have also improved the image export from charts to always correctly show highlighted data 

points. 

Sensitivities 

We have added sensitivities to TreeTop as a new document type. Sensitivities can be run against any 

node in a tree. In this release, one- and two-way sensitivities to value are supported. Note that 

sensitivities to probability can be achieved by linking probabilities to Excel cells in a workbook. We 

will draft a white paper shortly after release that explains how to run sensitivities, including many 

examples shortly after release. 
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TreeTop 5.0.1896.0 (September 18th, 2019) 

This is a feature release with a focus on overall usability and specific improvements for Value of 

Information trees. 

Application Shell 

Project Navigator 

The document tab design, which was loosely based on the Microsoft Excel user interface has created 

a lot of user feedback in the past. In particular, TreeTop projects often contain more documents 

than can be displayed on the tab control. Reviewing the feature requests that have been submitted 

for the tab interface led us to the conclusion that the tab interface could not realistically be 

amended to fulfill all requests. We thus took a step back and decided to re-design the document 

navigation within TreeTop completely. 

The new Project Navigator opens a document panel similar to DTrio when clicked. Note that settings 

and help are available in the top-right of the Project Navigator panel. 

  

Document Ribbon Tab 

We have replaced the various document specific ribbon tabs with a single, context sensitive, 

Document ribbon tab. If this ribbon tab is active, it tracks the currently selected document changing 

buttons etc. accordingly. This greatly reduces the number of mouse clicks required in the 

application. 

Better High DPI support 

As high dpi displays are more common now, we’ve made a variety of changes to support high dpi 

environments, such as 4k displays better. The most noticeable change is a completely new icon set 

for the application. Other minor improvements can be found throughout the applications – some 

are only noticeable in high dpi environments. 
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Other changes 

We have slightly changed the application start-up sequence to avoid having an obscured “New 

Project” window that may be hiding behind other applications. 

The Excel initialization sequence has been tightened in a variety of ways to be more fault tolerant 

when third party Excel add-ins are causing problems in Excel automation mode. 

A new Enersight command is now supported in TreeTop Enterprise (Scenario – Escalations). 

Various performance improvements. 

Under some circumstances, many of the on-screen elements of TreeTop were displayed in bold font. 

This has been identified and fixed. 

Trees 

New Value of Information Wizard 

The Bayesian Subtree Wizard has been replaced with a new Value of Information Subtree Wizard. The 

wizard is available from the Document ribbon. The interface is loosely modeled on the DTrio XL 

wizard, but offers many features that are specific to TreeTop, such as the ability to tie to an Excel 

workbook for calculations and the ability to handle up to five branches for uncertainties. 

The wizard can be used multiple times within the same tree. This allows the end user to easily add 

complex VOI scenarios (such as multiple VOIs in a row) to any project. 

 

Game Theory / Multiple Metrics Display 

We added an option to avoid repeated rendering of the metric names in the tree for end nodes 

when horizontal display is used. The metric names now always show in the level headers bar and 

can be switched off within the tree. 
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In particular, for game trees, which are often quite compact, this can lead to significantly cleaner 

views. 

 

 

Bug Fixes & Improvements 

The right-click context menu did not show icons correctly on some systems. 

Adding/inserting nodes via right-click context menu could lead to an infinite loop if the parent nodes 

were linked to each other. 

In rare circumstances, the various in-place editors could stay on screen when they should have gone 

away. Sometimes this led to an application crash. 

In-place editors now react to changes in level width immediately, if they currently have focus. 

Tornados 

There was a rare crash in the Tornado column mapping wizard if the user provided invalid 

references consisting of multiple areas in the workbook. 

Tornado Comparisons 

The report view has been improved – the report chart layout was changed slightly to match the chart 

view better in terms of dimensions and has been augmented with the metric that is displayed. In 

addition, the report view now updates immediately if the chart is changed, without having to go to 

the chart to make formatting changes.  

There have been a number of minor visual adjustments and improvements. 

Range of Value Curves 

We added a new feature, accessible via the ribbon to copy legend data to the system clipboard for 

pasting into various target applications, such as spreadsheet programs. 
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The ribbon commands now work when viewing the report tab – the chart is immediately refreshed, 

removing the need to go to the chart tab to edit the chart appearance and then going back to the 

report. 

Various other small improvements. 

Bug Fixes 

The data table export could crash if the destination file was in use by another application.  

When creating a Range of Value curve from a tree, the initially displayed metric is always set to be 

the same metric that is currently shown in the tree. Sometimes the metrics drop-down in the 

bottom right did not correctly reflect the metric that was currently displayed until the chart was 

refreshed once after creation.  

Corporate Licensing and Telemetry 

This release features application support for corporate licensing. In scripted environments 

(application deployed by IT) it is now possible to inject a corporate user license as part of the 

installation. This removes the need to obtain a license code from Decision Frameworks for 

application end-users. This feature requires registry keys to be added as part of the scripted 

installation – please contact us for more details. 

In addition to corporate licensing, we have also added application telemetry. Application telemetry 

allows us to gauge feature usage to aid direct our software development efforts. In addition, in 

corporate licensing environments, application telemetry is used to verify total user counts. 

Known Problems 

Under Windows 7/8, a small number of icons/glyphs may not be drawn correctly and replaced with a 

small rectangle. This depends on the update status of the installed system fonts. 
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TreeTop 5.0.1713.0 

This is a maintenance release with a few new features. The focus of this release was on 

improvements of our calculation engines. We have also fixed all reported bugs. 

Calculation Engine Changes – Excel and Enersight 

Nodes that contain error values (#REF, #NA, etc. from Excel; error messages from Enersight) are 

recalculated when Calculate is clicked in the ribbon. This avoids having to clear a tree to get rid of 

unwanted calculation engine specific runtime errors and throwing away good results. 

In addition, we have also added a right-click option to clear specific nodes / subtrees. Again, this 

avoids having to recalculate an entire tree to update a few nodes. 

 

When working with Excel models, please note that none of these changes apply to Automatic 

calculation mode. Users must enter Manual calculation mode to enable recalculation of runtime 

error results and to be able to manually reset partial trees. This restriction does not apply to 

Enersight based projects, as Automatic mode is not available. 

Logging 

TreeTop always had application logging built in, but it was by design hidden from end users. We 

have revisited this design decision and made changes to the logging framework and exposed the 

settings. End users are now easily able to configure application logging. 



 

© 2025 Decision Frameworks L.P. All rights reserved.  Page 19 

Please note that turning application logging on at any level may have a severe performance impact 

on TreeTop. We strongly suggest to only switch logging on when requested to do so by Decision 

Frameworks support.  

Changes to application logging settings require an application restart to take effect. 

 

Enersight Link – TreeTop Enterprise 

This version introduces a rewritten link to Enersight to improve stability, resilience and recovery in 

various scenarios. 

To enable users to customize the behavior depending on the complexity of the Enersight models, we 

have exposed a few settings via end user options. These are accessible from Options -> Enersight. 

The maximum batch size determines how many scenarios are queued in Enersight in parallel. A 

higher value may lead to better performance; however, in the case of failure, more results may be 

impacted. 

The client-side timeout determines a time after which TreeTop will terminate the current batch. Note 

that this is a delta-timeout, not a total batch time. I.e., the timer is reset as soon as progress is 

reported by Enersight. 
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Enersight Commands – TreeTop Enterprise 

We have added a number of new commands that are available to match the Enersight risk scripting 

command set. 

Other Minor Changes and Bug Fixes 

We have slightly improved the display of error messages in trees, in particular for end nodes. That 

makes errors generated by the calculation engine much more visible and easier to read. 

The Bayesian Subtree Wizard could crash under some conditions when it was invoked in places of a 

tree where it could not operate, in particular in the middle of trees with linked nodes. The button to 

invoke the wizard is now disabled in scenarios where it doesn’t make sense to invoke it and it would 

thus be unable to operate correctly. 

Very rarely, Excel references could “vanish” from the Tornado “Cell to Vary” setting. This has been 

fixed. 

In Enersight based Tornados, changes to the setup/teardown commands did not result in cleared 

results, forcing the user to clear and calculate. This has been fixed. 

In addition, a number of smaller bugs have been fixed. 
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TreeTop 5.0.1662.0 (TreeTop 2018) 

The various 4.0 releases of TreeTop were Enterprise releases, in which new features were piloted. 

TreeTop 5.0 brings the advancements of the Enterprise releases to the Professional version of 

TreeTop. From version TreeTop 5.0, the Enterprise and Professional versions of TreeTop are a single 

code base distributed via a single installer. Enterprise features are enabled with specific activation 

codes. 

TreeTop 2018 features a new application shell to take advantage of the new Microsoft user interface 

guidelines. 

 

In addition, TreeTop 2018 brings a host of improvements for various charting features. All charts 

support customizable font scaling. Tornado Comparisons have new display modes and Range of 

Value curves support highlighting of specific points, in addition to filtering. 

We have also added a new metric type – Simple Ratio metrics allow the calculation of typical 

profitability indicators (such as PI, PIR, VIR, CER, DPI) without using an external Excel calculation. 

Simple ratio calculations in TreeTop are very performant, resulting in an overall performance 

increase of around 40% for typical models that have a separately defined simple ratio metric. 

Lastly, we have re-worked our entire graphics stack for better performance on laptops without 

dedicated graphics cards and swapped out third party libraries that caused problems for a few 

users. 
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New Application Shell 

TreeTop 2018 features a completely new application shell. This application shell offers typical 

features seen in the latest Office applications, such as the new ribbon and application backstage 

pages. 

Users can access the license information from within the application now and change the license 

(for example, to upgrade from a Professional to an Enterprise license). Changing license is available 

from the File menu. 

The new application shell supports theming similar to the theming support in DTrio and OWL. 

Theming is available from the application options (File → Options → Appearance). 

 

We have also changed all fonts throughout the application for better readability. 

The progress screens have been changed for TreeTop 2018 to report more details on the 

calculation. This aids in particular with longer running calculations. 

Simple Ratio Metrics 

TreeTop 2018 introduces a new metric type. In addition to Roll-back and Excel calculated metrics, 

we’ve added Simple Ratio metrics. This new metric type aims to replace Excel calculated metrics for 

various capital efficiency metrics used by most, if not all, of our users. Performing the division in 

TreeTop rather than using Excel for the simple division offers significant performance benefits. In 

our testing, typical case study example calculation times improved by around 40%. 

They work – similar to Excel calculated metrics – by making the appropriate division at every node in 

the tree, rather than rolling back the results of a division. 

We encourage all users to switch simple ratio-based metrics, such as PI, PIR, VIR, CER, DPI to this 

new metric type, rather than continuing to use Excel spreadsheets for these metrics. 
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Trees 

Trees have a slightly updated look in TreeTop 2018. In addition to adopting the new look, we have 

also made usability improvements in a number of places, leveraging our drag/drop reordering 

technologies. For example, substitutions in the Nodes Properties window are now reordered via 

drag drop. 

Tornados 

Tornado charts have been improved significantly in TreeTop 2018. In addition to a new, cleaner look 

and better display of the various numeric data, we have added font scaling to Tornado charts. 

The new default look of bars is a Flat look. Users that preferred the Beveled look of TreeTop 4.0 and 

earlier can switch to that display in the ribbon. 

The algorithm used to choose the display of significant digits of inputs has been improved. “Floating 

bars”, resulting from step changes in the model, have been addressed in a different manner from 

previous versions of TreeTop. All available data points are now displayed – a tornado bar that was 

displayed as a floating bar in the past is now drawn in a lighter shade in the part connecting it with 

the base line. 
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The Tornado Editor and Data Table have seen slight improvements in the usability as part of the 

transition to our new TreeTop 2018 look and feel. 

Tornado Comparisons 

In addition to changes made to the Tornado engine above, Tornado Comparisons have gained a 

wide variety of display options. 

 

By combining the new Chart Types with Bar Coloring settings, users can achieve many different looks, 

potentially illuminating various comparative features of the chosen Tornados. We encourage users 

to habitually look at the different Chart Types and Bar Coloring modes when comparing Tornados to 

gain more insights. 
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The comparison view of TreeTop 2014 is still available. It is the Variables comparison of the Chart 

Type selection. 

Range of Value Curves 

In addition to cleaner looking charts and font sizing, we have added highlighting to range of value 

curves. This allows users to very quickly see which points carry certain components, such as 

“highlight all points with a P10 Oil Price component”. This feature has been added to the filtering 

panel in the bottom right of the screen. Note that multiple selection results in an “or” combination of 

components. 

 

We have also redesigned the various end-user customizations for the chart appearance into a single 

drop-down menu for each series. The available customizations are still the same, however the 

redesigned UI access for these features removed the requirement for a switch between an editable 

legend and display legend. 
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Bug fixes 

All client reported bugs and automated crash reports have been addressed. 

  



 

© 2025 Decision Frameworks L.P. All rights reserved.  Page 27 

TreeTop 3.0.1152.0 (TreeTop 2014) 

This feature release marks the release of TreeTop 2014.  

Manual Calculation Mode 

We introduce manual calculation mode to offer a high degree of control over TreeTop for large 

projects, or projects with slow calculation engines. Automatic calculation mode is still available, and 

is the default calculation setting for new projects. Manual calculation mode also takes advantage of 

the smart recalculation features of the TreeTop calculation engine to only calculate those parts of 

the project that have been invalidated by changes. 

The former Excel ribbon tab has been renamed to Calculation and has received additional buttons to 

expose the new functionality. 

In addition, calculation related buttons from the Home ribbon tab have been migrated to the 

Calculation ribbon tab to keep buttons with similar functions together. 

 

Multiple Metrics View Mode 

TreeTop’s unique calculation engine allows independent switching between decision metrics and 

view metrics. Coupled with the capabilities of logic nodes, this has always made TreeTop a strong 

tool for evaluating both traditional decision tree problems, as well as game theory problems. 

However, especially for game theory applications of TreeTop, the display of multiple metrics at the 

same time was a core request. We have implemented this request along minor work on logic nodes 

to make TreeTop a first choice tool for game theory. 

 

In addition to game theory applications, the multiple metric view mode has already proven its 

usefulness in traditional tree scenarios during closed beta testing. 

Multiple metric view mode is selected from the View drop-down, located in the Display group of the 

Tree ribbon tab (1). Choosing Edit Multiple Metrics (2) allows customization in a dialog (3). Note that 

only messages prompting the user to customize are displayed in the tree when Multiple Metric 
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mode is selected until the user has customized the mode using the dialog. Multiple Metric display 

customization is per-tree, i.e., needs to be done separately for each tree in a TreeTop project. 

 

We will publish white papers soon after the release of TreeTop 2014 to introduce game theory 

applications for TreeTop to those users that have had only little exposure to this specific class of 

problems in the past. 

In addition, we are working on a white paper that shows applications of multiple metrics view modes 

in traditional tree evaluations. 

Please check our website from time to time for the availability of these white papers. 

More Control Over Tree Display 

We have added the ability to hide some of the decorative and lesser used user interaction elements 

in the tree until the mouse hovers over them, or completely. This allows users to clean up the 

display in editing view mode, for example, or to remove optimal path visual hints for discussion of a 

strategy tree. 

The buttons for this functionality are located on the Tree ribbon tab in the Display group. 

Additionally, we have also increased the maximum vertical spacing, to allow those view modes which 

use a lot of vertical screen real estate, such as auditing mode and multiple metrics, to expand 

further vertically. 
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Help Videos and Welcome Screen 

We have produced a variety of help videos in the past months, which are available from our web 

site. In order to make users aware of these, we have added a Welcome dialog which makes users 

aware of these, as well as this release notes document. 

 

Whether the welcome screen is displayed at every start or not can be controlled from within the 

dialog (Show at startup checkbox). The dialog can also be accessed from the Help group of the Home 

ribbon tab. 

 

The videos can be accessed directly from the same group. 

Complete List of Changes 

New Features 

1. Introduced manual calculation mode with ribbon control buttons under Calculation ribbon 

tab. 

2. Introduced multiple metrics view mode 

a. Also added a dialog to allow user customization of some aspects of the display of 

this mode. 

3. Tree branch labels that are linked to cells are now retrieved even when Excel calculation is 

paused. 
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4. Tornado variable names and low/base/high labels are now retrieved even when Excel 

calculation is paused. 

5. The Tornado Auto Fill wizard now retrieves values for the Excel mapping screen even when 

Excel calculations are paused. 

6. Improved rendering of error icons on tree for better performance and better image quality 

when zooming. 

7. Increased maximum vertical spacing in trees (user definable). This allows for more space 

with view modes that display multiple lines of information below the node branches.  

8. Added user controllable tree display settings that can be applied in most view modes. This 

enables the user to hide visual cues which are not required for the current task. 

a. highlight optimal path 

b. display probability lock 

c. display reward entry cue 

9. Changed the display of indented nodes (‘skip level’) to left-align text on the node branch and 

take advantage of the additional horizontal display space. 

10. End nodes are now decorated with a calculation icon to augment the text message 

(“Calculate” or “Paused”). This denotes that calculation is required because either manual 

calculation mode is selected, or because automatic mode is selected and calculations have 

been paused. 

11. Added billboard to make user aware of Range of Value curve requiring calculation if all 

curves need calculation. 

12. Added calculation prompts to Range of Value curve legend to make user aware of a subset 

of curves on a chart requiring calculation (used to show “Error” before). 

13. Added a new Welcome Screen to make users aware of the new help videos that we have 

produced, as well as this document. 

14. Made Help Videos available via a ribbon button for quick access to the web page. 

Breaking Changes 

1. Changed macro execution code to skip call to Excel Calculate before macro execution. It is 

now the macro's responsibility to calculate the workbook prior to execution, if this is 

required. 

Note: This may require the addition of an Excel Calculate call to some macros to function 

in the same manner as previous releases of TreeTop. Most macros are however not 

impacted by this change, as many actions that are typically performed by macros 

automatically cause a calculation call. In any case, a call to Excel Calculate is only 

required if the macro requires intermediate results from the spreadsheet. 

Other Changes 

2. Much improved automatic assignment of probabilities to uncertainty branches. 
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3. Upgraded third party crash reporting component to latest version (same as DTrio NG) – this 

allows optional collection of email address from user submitting crash reports to follow up 

when reproduction of crash fails. 

4. Ribbon Changes to consolidate calculation functionality 

a. Renamed “Excel” ribbon tab to “Calculation”. 

b. Introduced new “Calculation Control” group within ribbon tab. 

c. Moved “Pause” button to “Calculation Control”. 

5. The range of value curve now recalculates Excel calculated metrics (such as VIR, PIR, PI, …) on 

the fly for Range of Value curve expected values. This yields a result that corresponds to 

building the equivalent tree, making the EV more accurate in some cases.  

o Note: This does not impact the actual curve that is generated. 

6. Additional changes to accommodate Excel multi-threading issues. A change in the multi-

threading (parallel computation) of Excel causes incorrect call termination notices to be 

generated by Excel; subsequent calls to Excel may fail, if Excel reported that a previous task 

was finished, when in fact it was still being processed. TreeTop now recognizes when this 

happens and re-tries after a short wait to allow the previous task to finish. 

7. Change: Changed the order of the logic editor to display “Default” first, followed by branch 

logic to encourage a user to pick a default branch first and thus eliminate duplicated effort 

(entering logic for a branch that is subsequently picked as a default branch and thus 

executed no logic). 

8. Improved heuristics for tree calculation progress. 

Bug Fixes 

1. Bug fix: When inserting tab items in a project, the TreeTop project file was irrecoverably 

corrupted under some circumstances. 

2. Bug fix: TreeTop installer did not always remove previous versions from Windows 

Add/Remove programs dialog (old versions where in fact removed from disk; just the 

program entry remained). 

3. “Tornado Autofill Wizard” and “Tree from Tornado Wizard” now open on the same monitor 

as the main application on multi-monitor setups 

4. Bug fix: Under rare conditions it was possible that TreeTop crashed due to a race condition 

in the Excel substitution engine. 

5. Bug fix: Range of Value curve did not use selected marker style for curves (always defaulted 

to square). This was introduced in release 2.2.845.0 as part of the performance work for 

switching metrics on range of value curves. 

6. Bug fix: Range of Value curve legend could show positive probabilities in red under some 

circumstances. 

7. Bug fix: Fixed a threading issue in the Range of Value curve that could lead to a crash under 

rare circumstances. 

8. Bug fix: Under rare circumstances, TreeTop would stop updating the vertical spacing 

between nodes when changed by the user until the tab was re-activated. 
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9. Bug fix: In certain tree-node combinations that combined nodes that used look-ahead for 

calculation of joint probability, inserting a node via mouse-right click could cause a crash. 

10. Bug fix: On Tornado Comparisons, the mini-Tornados “Base” labelling number format was 

sometimes incorrect. 

11. Bug fix: Removing a metric that was used as a part of the definition of a logic node in the 

tree could lead to a crash. 

Additional minor bugs fixed and performance tuning changes. 
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TreeTop 2.2.892.0 

Release 2.2.892.0 is a minor change release which offers small features and additional bug fixes 

which were reported after the release of v2.2.845.0. 

1. Added support for local named ranges in Excel models 

2. All charts now contain a metric caption for the in-built screen capture (Tornado, Tornado 

Comparison, Range of Value Curves) 

a. Additionally Tornados and Tornado Comparisons have x-axis captions outlining the 

value of all variables at P50 and number of Tornados compared respectively. 

3. Removed “Auto Tree” text that was pre-pended to tree names when trees are generated 

from Tornados. This was a remnant from a previous version of TreeTop where tabs did not 

have type icons and could only be distinguished by name. 

4. Bug fix: Deleting a component of an XL calculated metric whilst viewing a Tornado causes 

TreeTop to crash on some machines 

5. Bug fix: Invalid file path supplied during save of TTP file causes TreeTop to crash 

6. Bug fix: Tornado editor small visual bug fixes 

Additional minor bugs fixed. 
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TreeTop 2.2.845.0 

Release 2.2.845.0 is a bug fix release for TreeTop 2013. 

1. Fixed crash when opening a TreeTop project after extensive changes to the underlying 

workbook were performed offline, such as moving worksheets between linked workbooks. 

2. Fixed crash when using Range Mapping Wizard from within Tornado whilst Excel Interaction 

was paused. 

3. Bug fix: Network drives were sometimes not correctly recognized leading to TreeTop 

refusing to open Excel workbooks that were stored on network drives. 

4. Bug fix: De-serializing Tornado caused cached data to be invalidated forcing a re-calculation 

of Tornado results when opening a previously fully calculated project. 

5. Numerous bug fixes and improvements for international (non-US English) regional settings 

of Windows. 

6. Performance improvements for scenarios where Range of Value curves had thousands of 

markers for some metrics but only dozens of markers for other metrics. 

7. Bug fix: TreeTop entered an infinite loop when a metric had zero variability across all results 

for a Range of Value curve. 

8. Added code to recover corrupted TreeTop files. This works for minor corruptions, such as a 

“bit flip” due to a faulty hard drive sector. 

9. Recognize a mixed mode Office installation (e.g., Office 2010 with Lync 2013) and display a 

corresponding error message. TreeTop does not start until this PC configuration error has 

been resolved. A corresponding help topic was added to the online help and is reachable via 

the error message. 

10. Numerous changes to accommodate Excel multi-threading issues. A change in the multi-

threading (parallel computation) of Excel causes incorrect call termination notices to be 

generated by Excel; subsequent calls to Excel may fail, if Excel reported that a previous task 

was finished, when in fact it was still being processed. TreeTop now recognizes when this 

happens and re-tries after a short wait to allow the previous task to finish. 

Additional minor bugs fixed and performance improvements. 
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Contact Information 

If you have any questions or experience any problems, please contact 

support@decisionframeworks.com or call +1 713-647-9736 during normal business hours which are 

9:00 a.m. – 5:00 p.m. CST. 
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